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Copyright
Copyright © 2009 Nokia. All rights reserved.

Reproduction, transfer, distribution or storage of part or all of the contents in this document in any form
without the prior written permission of Nokia is prohibited.

Nokia, Nokia Connecting People, and Nokia X and Y are trademarks or registered trademarks of Nokia
Corporation. Other product and company names mentioned herein may be trademarks or tradenames of
their respective owners.

Nokia operates a policy of continuous development. Nokia reserves the right to make changes and
improvements to any of the products described in this document without prior notice.

Under no circumstances shall Nokia be responsible for any loss of data or income or any special, incidental,
consequential or indirect damages howsoever caused.

The contents of this document are provided "as is". Except as required by applicable law, no warranties of
any kind, either express or implied, including, but not limited to, the implied warranties of merchantability
and fitness for a particular purpose, are made in relation to the accuracy, reliability or contents of this
document. Nokia reserves the right to revise this document or withdraw it at any time without prior notice.

The availability of particular products may vary by region.

IMPORTANT
This document is intended for use by qualified service personnel only.
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Warnings and cautions

Warnings
• IF THE DEVICE CAN BE INSTALLED IN A VEHICLE, CARE MUST BE TAKEN ON INSTALLATION IN VEHICLES FITTED

WITH ELECTRONIC ENGINE MANAGEMENT SYSTEMS AND ANTI-SKID BRAKING SYSTEMS. UNDER CERTAIN FAULT
CONDITIONS, EMITTED RF ENERGY CAN AFFECT THEIR OPERATION. IF NECESSARY, CONSULT THE VEHICLE DEALER/
MANUFACTURER TO DETERMINE THE IMMUNITY OF VEHICLE ELECTRONIC SYSTEMS TO RF ENERGY.

• THE PRODUCT MUST NOT BE OPERATED IN AREAS LIKELY TO CONTAIN POTENTIALLY EXPLOSIVE ATMOSPHERES,
FOR EXAMPLE, PETROL STATIONS (SERVICE STATIONS), BLASTING AREAS ETC.

• OPERATION OF ANY RADIO TRANSMITTING EQUIPMENT, INCLUDING CELLULAR TELEPHONES, MAY INTERFERE
WITH THE FUNCTIONALITY OF INADEQUATELY PROTECTED MEDICAL DEVICES. CONSULT A PHYSICIAN OR THE
MANUFACTURER OF THE MEDICAL DEVICE IF YOU HAVE ANY QUESTIONS. OTHER ELECTRONIC EQUIPMENT MAY
ALSO BE SUBJECT TO INTERFERENCE.

• BEFORE MAKING ANY TEST CONNECTIONS, MAKE SURE YOU HAVE SWITCHED OFF ALL EQUIPMENT.

Cautions
• Servicing and alignment must be undertaken by qualified personnel only.

• Ensure all work is carried out at an anti-static workstation and that an anti-static wrist strap is worn.

• Ensure solder, wire, or foreign matter does not enter the telephone as damage may result.

• Use only approved components as specified in the parts list.

• Ensure all components, modules, screws and insulators are correctly re-fitted after servicing and
alignment.

• Ensure all cables and wires are repositioned correctly.

• Never test a mobile phone WCDMA transmitter with full Tx power, if there is no possibility to perform the
measurements in a good performance RF-shielded room. Even low power WCDMA transmitters may disturb
nearby WCDMA networks and cause problems to 3G cellular phone communication in a wide area.

• During testing never activate the GSM or WCDMA transmitter without a proper antenna load, otherwise
GSM or WCDMA PA may be damaged.
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For your safety

QUALIFIED SERVICE
Only qualified personnel may install or repair phone equipment.

ACCESSORIES AND BATTERIES
Use only approved accessories and batteries. Do not connect incompatible products.

CONNECTING TO OTHER DEVICES
When connecting to any other device, read its user’s guide for detailed safety instructions. Do not connect
incompatible products.
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ESD protection
Nokia requires that service points have sufficient ESD protection (against static electricity) when servicing
the phone.

Any product of which the covers are removed must be handled with ESD protection. The SIM card can be
replaced without ESD protection if the product is otherwise ready for use.

To replace the covers ESD protection must be applied.

All electronic parts of the product are susceptible to ESD. Resistors, too, can be damaged by static electricity
discharge.

All ESD sensitive parts must be packed in metallized protective bags during shipping and handling outside
any ESD Protected Area (EPA).

Every repair action involving opening the product or handling the product components must be done under
ESD protection.

ESD protected spare part packages MUST NOT be opened/closed out of an ESD Protected Area.

For more information and local requirements about ESD protection and ESD Protected Area, contact your local
Nokia After Market Services representative.
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Care and maintenance
This product is of superior design and craftsmanship and should be treated with care. The suggestions below
will help you to fulfil any warranty obligations and to enjoy this product for many years.

• Keep the phone and all its parts and accessories out of the reach of small children.

• Keep the phone dry. Precipitation, humidity and all types of liquids or moisture can contain minerals that
will corrode electronic circuits.

• Do not use or store the phone in dusty, dirty areas. Its moving parts can be damaged.

• Do not store the phone in hot areas. High temperatures can shorten the life of electronic devices, damage
batteries, and warp or melt certain plastics.

• Do not store the phone in cold areas. When it warms up (to its normal temperature), moisture can form
inside, which may damage electronic circuit boards.

• Do not drop, knock or shake the phone. Rough handling can break internal circuit boards.

• Do not use harsh chemicals, cleaning solvents, or strong detergents to clean the phone.

• Do not paint the phone. Paint can clog the moving parts and prevent proper operation.

• Use only the supplied or an approved replacement antenna. Unauthorised antennas, modifications or
attachments could damage the phone and may violate regulations governing radio devices.

All of the above suggestions apply equally to the product, battery, charger or any accessory.
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Company policy
Our policy is of continuous development; details of all technical modifications will be included with service
bulletins.

While every endeavour has been made to ensure the accuracy of this document, some errors may exist. If
any errors are found by the reader, NOKIA MOBILE PHONES Business Group should be notified in writing/e-
mail.

Please state:

• Title of the Document + Issue Number/Date of publication

• Latest Amendment Number (if applicable)

• Page(s) and/or Figure(s) in error

Please send to:
NOKIA CORPORATION

Nokia Mobile Phones Business Group

Nokia Customer Care

PO Box 86

FIN-24101 SALO

Finland

E-mail: Service.Manuals@nokia.com
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Battery information
Note: A new battery's full performance is achieved only after two or three complete charge and
discharge cycles!

The battery can be charged and discharged hundreds of times but it will eventually wear out. When the
operating time (talk-time and standby time) is noticeably shorter than normal, it is time to buy a new battery.

Use only batteries approved by the phone manufacturer and recharge the battery only with the chargers
approved by the manufacturer. Unplug the charger when not in use. Do not leave the battery connected to
a charger for longer than a week, since overcharging may shorten its lifetime. If left unused a fully charged
battery will discharge itself over time.

Temperature extremes can affect the ability of your battery to charge.

For good operation times with Li-Pol batteries, discharge the battery from time to time by leaving the product
switched on until it turns itself off (or by using the battery discharge facility of any approved accessory
available for the product). Do not attempt to discharge the battery by any other means.

Use the battery only for its intended purpose.

Never use any charger or battery which is damaged.

Do not short-circuit the battery. Accidental short-circuiting can occur when a metallic object (coin, clip or
pen) causes direct connection of the + and - terminals of the battery (metal strips on the battery) for example
when you carry a spare battery in your pocket or purse. Short-circuiting the terminals may damage the battery
or the connecting object.

Leaving the battery in hot or cold places, such as in a closed car in summer or winter conditions, will reduce
the capacity and lifetime of the battery. Always try to keep the battery between 15°C and 25°C (59°F and 77°
F). A phone with a hot or cold battery may temporarily not work, even when the battery is fully charged.
Batteries' performance is particularly limited in temperatures well below freezing.

Do not dispose of batteries in a fire!

Dispose of batteries according to local regulations (e.g. recycling). Do not dispose as household waste.
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 Product selection
RM-529, RM-530 and RM-584 are quadband phones. RM-529 supports WCDMA850/1900/2100 bands and
WLAN. RM-530 supports WCDMA900/1900/2100 bands and WLAN. RM-584 supports WCDMA850/1900/2100
bands, but does not support WLAN. The devices have HSDPA and HSUPA.

For WCDMA the maximum bit rate is up to 384 kbit/s for downlink and 384 kbit/s for uplink with simultaneous
CS speech or CS video (max. 64 kbit/s). The HSDPA peak is 10.2 Mbps and HSUPA peak is 2 Mbps (with limited
use cases).

In PS/CS mode, the device supports DTM Class with multi slot class 11 (max. 4 RX + 3TX, sum 5). With EGPRS
this means maximum download speed of up to 236.8 kbit/s simultaneously with speech. With GPRS this
means maximum download speed of up to 64.2 kbit/s simultaneously with speech.

In PS only mode, the device supports MSC 32 (max. 5 Rx + 3 TX, sum 6) timeslots resulting in maximum
download speed of up to 296 kbit/s with EGPRS, and up to 107kbit/s with GPRS

The device is an MMS (Multimedia Messaging Service) enabled multimedia terminal. The MMS implementation
follows the OMA MMS standard release 1.2. The device also supports A-GPS, and Bluetooth 2.0 standard with
stereo audio profiles (A2DP & AVRCP).

The device has a QVGA 2.4” display (320 x 240) capable of displaying 16 million colours and an integrated 5
Mpix autofocus camera with flash. The 2nd VGA camera is for video calls.

The device uses Symbian 9.3 operating system, S60 (release 3.2) UI, and supports the full Web Browser for
S60 which brings desktop-like Web browsing experience to mobile devices.

The device also supports MIDP Java 2.0, providing a good platform for compelling 3rd party applications.

Figure 1 View of RM-530
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 Product features and sales package

Bearers and transport
• CSD, HSCSD

• GPRS/EGPRS Class B, Multi slot class 32

• Dual Transfer Mode (DTM) class A, multi slot class 11

• WCDMA DL 384 kbit/s, UL 384 kbit/s

• HSDPA up to 10.2 Mbps

• HSUPA 2 Mbps

Connectivity
• Assisted GPS (A-GPS)

• WLAN (not in RM-584)

• Bluetooth 2.0 with stereo audio profiles (A2DP and AVRCP)

• High Speed USB with micro USB connector

• MicroSD memory card - support up to 16 GB

• 3.5 mm AV connector

Display
• QVGA 2.4” display (320 x 240), 16M colours

• Digital Ambient Light Sensor (ALS) – used to optimize display/key brightness and power consumption

• Orientation sensor (accelerometer) assisted UI turn (portrate / landscape) and turn-to-mute

Imaging and video
• 5 Mpix autofocus camera

• 2nd VGA camera for video calls

• Video streaming and sharing

• Dedicated keys for image capture, recording and zooming

• Image and video editors

Music
• Music player with MP3/AAC/AAC+/eAAC+/WMA support

• Noise cancellation (2- MIC noise cancellation for uplink)

• Speech codec support for AMR-WB, AMR, FR, EFR

• Mono IHF speaker

• RDS FM Radio

Productivity
Context management

• OMA DRM version 2.0

• PIM (Calendar + Contacts + Active Notes)

• OTA provisioning & over the air SW update (FOTA)

• PC Suite for local data synchronization

RM-529; RM-530; RM-584
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• Ovi

• Active Standby

• Active Synch data synchronization

• Web Browser (OSS), Java ™ MIDP 2.0, XHTML browsing over TCP/IP

Messaging

• Email (SMTP, IMAP4, POP3)

• SMS, MMS (OMA 1.3)

• Audio Messaging (AMS)

Voice

• Rich Calls: 2-way video conferencing (video call), video sharing

• Voice commands, enhanced voice dialling (SIND)

• Audio message reader for text messages and E-mail

• VoIP calls

Add-on software framework
• Symbian OS 9.3

• Nokia Series 60, 3rd edition, feature pack 3.2

• Java: MIDP2.0

Additional features
• City compass to support easy pedestrian routing and guidance

• Status LED light around navi-key to indicate events like missed call, SMS etc.

• Vibrating alert

• Speech codec support for AMR-WB, AMR, FR, EFR

Basic sales package
Basic sales package, there may be sales area variations.

• Transceiver RM-529, RM-530 or RM-584

• Battery (BP-4L/1500mAh)

• Travel charger AC-8

• Stereo headset (WH-601)

• Micro USB connectivity cable (CA-101)

• MicroSD card 4GB (MU-41)

• Nokia PC Suite in microSD card

• Short user guide

 Product and module list

Module name Type code Notes

System/RF module PWB 2WS

UI flex PWB 2WT

Flash light PWB 2YD

RM-529; RM-530; RM-584
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Module name Type code Notes

AV flex PWB 2WU

 Mobile enhancements

Table 1 Audio

Enhancement Type

Headsets (stereo) WH-601 inbox

WH-500

WH-600

Wireless headsets (BT stereo) BH-503

BH-504

Table 2 Car

Enhancement Type

Car navigation Nokia 500 Auto Navigation

Car kit CK-7W

CK-15W

CK-100

CK-300 (BT & plug-in)

CK-600

FM transmitter CA-300

Holder CR-39

CR-82

CR-99

Mobile charger DC-4

Mobile holder easy mount HH-12

HH-17

Plug-in car handsfree HF-200

HF-300

HF-310

HF-510

Table 3 Data

Enhancement Type

MicroSD card, 512MB MU-28

MicroSD card, 1GB MU-22

RM-529; RM-530; RM-584
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Enhancement Type

MicroSD card, 2GB MU-37

MicroSD card, 4GB MU-41

MicroSD card, 8GB MU-43

MicroSD card, 16GB MU-44

Micro USB connectivity adapter cable CA-101/CA_101D

Table 4 Messaging

Enhancement Type

Digital pen SU-27W

Wireless keyboard SU-8W

Table 5 Music

Enhancement Type

Bluetooth speakers MD-5W (BT & plug-in)

MD-7W (BT & plug-in)

Music speakers MD-6

MD-8

Table 6 Navigation

Enhancement Type

Wireless GPS module LD-3W

LD-4W

Table 7 Power

Enhancement Type

Battery 1500 mAh Li-Polymer BP-4L

Charger adapter AC-146c

Charger AC-5

AC-8

DC-8

DC-9

DC-11

RM-529; RM-530; RM-584
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 Technical specifications

Transceiver general specifications

Unit Dimensions (L x W x T)
(mm)

Weight (g) Volume (cm3)

Transceiver with BP-4L
1500 mAh Li-Polymer
battery back

114 x 59.5 x 10.1 128 65

Main RF characteristics for GSM850/900/1800/1900 and WCDMA VIII/II/I phones

Parameter Unit

Cellular system GSM850, EGSM900, GSM1800/1900, WCDMA VIII
(900), WCDMA II (1900) and WCDMA I (2100)

Rx frequency band GSM850: 869 - 894 MHz

EGSM900: 925 - 960 MHz

GSM1800: 1805 - 1880 MHz

GSM1900: 1930 - 1990 MHz

WCDMA VIII (900): 925- 960 MHz

WCDMA II (1900): 1930-1990MHz

WCDMA I (2100): 2110 - 2170 MHz

Tx frequency band GSM850: 824 - 849 MHz

EGSM900: 880 - 915 MHz

GSM1800: 1710 - 1785 MHz

GSM1900: 1850 - 1910 MHz

WCDMA VIII (900): 880 - 915 MHz

WCDMA II (1900): 1850-1910MHz

WCDMA I (2100): 1920 - 1980 MHz

Output power GSM850: +5 ...+33dBm/3.2mW ... 2W

GSM900: +5 … +33dBm/3.2mW … 2W

GSM1800: +0 … +30dBm/1.0mW … 1W

GSM1900: +0 … +30dBm/1.0mW … 1W

WCDMA VIII (900): -50 ... +24 dBm/0.01μW ...
251.2mW

WCDMA II (1900): -50 ... +24dBm/0.01µW ...
251.2mW

WCDMA I (2100): -50 ... +24 dBm/0.01μW ...
251.2mW

RM-529; RM-530; RM-584
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Parameter Unit

EDGE output power EDGE850: +5 … +27dBm/3.2mW … 794mW

EDGE900: +5 … +27dBm/3.2mW … 794mW

EDGE1800: +0 … +26dBm/1.0mW … 400mW

EDGE1900:+0 … +26dBm/1.0mW … 400mW

Number of RF channels GSM850: 124

GSM900: 174

GSM1800: 374

GSM1900: 299

WCDMA VIII (900): 152

WCDMA II (1900): 289

WCDMA I (2100): 277

Channel spacing 200 kHz (WCDMA II 100/200 kHz)

Number of Tx power levels GSM850: 15

GSM900: 15

GSM1800: 16

GSM1900: 16

WCDMA VIII (900): 75

WCDMA II (1900): 75

WCDMA I (2100): 75

Main RF characteristics for GSM850/900/1800/1900 and WCDMA V/II/I phones

Parameter Unit

Cellular system GSM850, EGSM900, GSM1800/1900, WCDMA V (850), WCDMA II
(1900) and WCDMA I (2100)

Rx frequency band GSM850: 869 - 894MHz

EGSM900: 925 - 960 MHz

GSM1800: 1805 - 1880 MHz

GSM1900: 1930 - 1990 MHz

WCDMA V (850): 869 - 894 MHz

WCDMA II (1900): 1930 - 1990 MHz

WCDMA I (2100): 2110 - 2170 MHz
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Parameter Unit

Tx frequency band GSM850: 824 - 849MHz

EGSM900: 880 - 915 MHz

GSM1800: 1710 - 1785 MHz

GSM1900: 1850 - 1910 MHz

WCDMA V (850): 824 - 849 MHz

WCDMA II (1900): 1850 - 1910 MHz

WCDMA I (2100): 1920 - 1980 MHz

Output power GSM850: +5 ...+33dBm/3.2mW ... 2W

GSM900: +5 … +33dBm/3.2mW … 2W

GSM1800: +0 … +30dBm/1.0mW … 1W

GSM1900: +0 … +30dBm/1.0mW … 1W

WCDMA V (850): -50 ... +24 dBm/0.01μW ... 251.2mW

WCDMA II (1900): -50 ... +24 dBm/0.01μW ... 251.2mW

WCDMA I (2100): -50 ... +24 dBm/0.01μW ... 251.2mW

EDGE output power EDGE850: +5 … +27dBm/3.2mW … 794mW

EDGE900: +5 … +27dBm/3.2mW … 794mW

EDGE1800: +0 … +26dBm/1.0mW … 400mW

EDGE1900:+0 … +26dBm/1.0mW … 400mW

Number of RF channels GSM850: 124

GSM900: 174

GSM1800: 374

GSM1900: 299

WCDMA V (850): 108

WCDMA II (1900): 289

WCDMA I (2100): 277

Channel spacing 200 kHz (WCDMA V and II 100/200 kHz)

Number of Tx power levels GSM850: 15

GSM900: 15

GSM1800: 16

GSM1900: 16

WCDMA V (850): 75

WCDMA II (1900): 75

WCDMA I (2100): 75
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Battery endurance

Table 8 GSM

Battery Capacity (mAh) Talk time Stand-by

BP-4L 1500 ~6.5 h (GSM)

~5 h (WCDMA)

~450 h (GSM)

~500 h (WCDMA)

Charging times

AC-8

2 h

Environmental conditions

Temperature conditions

Environmental condition Ambient temperature Notes

Normal operation -15oC...+55oC Specifications fulfilled

Reduced performance -25oC...-15oC

+55oC...+70oC

Operational for shorts periods
only

Intermittent operation -40oC...-15oC

+70oC...+85 oC

Operation not guaranteed but an
attempt to operate does not
damage the phone.

No operation or storage <-40oC...>+85oC No storage or operation: an
attempt may damage the phone.

Charging allowed -25oC...+50oC

Long term storage conditions 0oC...+85oC

Humidity
Relative humidity range is 5...95%.

The HW module is not protected against water. Condensed or splashed water might cause malfunction. Any
submerge of the phone will cause permanent damage. Long-term high humidity, with condensation, will
cause permanent damage because of corrosion.

Vibration
The module should withstand the following vibrations:

• 5 - 10 Hz; +10dB / octave

• 10 - 50 Hz; 5.58 m2 / s3 (0.0558 g2/ Hz)

• 50 - 300 Hz; - 10 dB / octave

ESD strength
Conducted discharge is 8 kV (>10 discharges) and air contact 15 kV ( >10 discharges ).

The standard for electrostatic discharge is IEC 61000-4-2, and this device fulfils level 4 requirements.
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RoHS
This device uses RoHS compliant components and lead-free soldering process.
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 Service tools

Product specific tools
The table below gives a short overview of service devices that can be used for testing, error analysis, and
repair of product RM-529; RM-530; RM-584. For the correct use of the service devices, and the best effort of
workbench setup, please refer to various concepts.

FS-114 Flash adapter

For flashing (also dead phones) with SS-64. RF testing (with RF
coupler), and CU-4 supported.

MJ-222 Module jig

MJ-222 is meant for troubleshooting, testing, tuning and flashing on
the engine level (CU-4 supported).

The jig includes an RF interface for GSM, WCDMA and Bluetooth.

RJ-230 Soldering jig

RJ-230 is a soldering jig used for soldering and as a rework jig for the
engine module.

SA-131 RF coupler

SA-131 is a generic device for GPS testing. It is used together with
SS-62.

General tools
The table below gives a short overview of service devices that can be used for testing, error analysis, and
repair of product RM-529; RM-530; RM-584. For the correct use of the service devices, and the best effort of
workbench setup, please refer to various concepts.
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AC-35 Power supply

Universal power supply for FPS-21; included in the FPS-21 sales
package.

Input 100V…230V 50Hz…60Hz, output voltage of 12 V and output
current up to 3 A.

ACF-8 Universal power
supply

The ACF-8 universal power supply is used to power FLS-5.
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CU-4 Control unit

CU-4 is a general service tool used with a module jig and/or a flash
adapter. It requires an external 12 V power supply.

The unit has the following features:

• software controlled via USB

• EM calibration function

• Forwards FBUS/Flashbus traffic to/from terminal

• Forwards USB traffic to/from terminal

• software controlled BSI values

• regulated VBATT voltage

• 2 x USB2.0 connector (Hub)

• FBUS and USB connections supported

When using CU-4, note the special order of connecting cables and
other service equipment:

Instructions
1 Connect a service tool (jig, flash adapter) to CU-4.

2 Connect CU-4 to your PC with a USB cable.

3 Connect supply voltage (12 V)

4 Connect an FBUS cable (if necessary).

5 Start Phoenix service software.

Note: Phoenix enables CU-4 regulators via USB when it is
started.

Reconnecting the power supply requires a Phoenix restart.
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FLS-5 Flash device

FLS-5 is a dongle and flash device incorporated into one package,
developed specifically for POS use.

Note: FLS-5 can be used as an alternative to PKD-1.

FPS-21 Flash prommer

FPS-21 sales package:

• FPS-21 prommer

• AC-35 power supply

• CA-31D USB cable

FPS-21 interfaces:

Front
• Service cable connector

Provides Flashbus, USB and VBAT connections to a mobile device.

• SmartCard socket

A SmartCard is needed to allow DCT-4 generation mobile device
programming.

Rear
• DC power input

For connecting the external power supply (AC-35).

• Two USB A type ports (USB1/USB3)

Can be used, for example, for connecting external storage memory
devices or mobile devices

• One USB B type device connector (USB2)

For connecting a PC.

• Phone connector

Service cable connection for connecting Flashbus/FLA.

• Ethernet RJ45 type socket (LAN)

For connecting the FPS-21 to LAN.

Inside
• Four SD card memory slots

For internal storage memory.

Note: In order to access the SD memory card slots inside
FPS-21, the prommer needs to be opened by removing the
front panel, rear panel and heatsink from the prommer body.
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JXS-1 RF shield box

Because the WCDMA network disturbs the RX side testing of the WCDMA
phone and the Tx signal of the WCDMA phone can severely disturb the
WCDMA network, a shield box is needed in all testing, tuning and fault
finding which requires WCDMA RF signal.

The shield box is not an active device, it contains only passive filtering
components for RF attenuation.

PK-1 Software protection
key

PK-1 is a hardware protection key with a USB interface. It has the same
functionality as the PKD-1 series dongle.

PK-1 is meant for use with a PC that does not have a series interface.

To use this USB dongle for security service functions please register
the dongle in the same way as the PKD-1 series dongle.

SB-6 Bluetooth test and
interface box (sales
package)

The SB-6 test box is a generic service device used to perform Bluetooth
bit error rate (BER) testing, and establishing cordless FBUS connection
via Bluetooth. An ACP-8x charger is needed for BER testing and an
AXS-4 cable in case of cordless interface usage testing .

Sales package includes:

• SB-6 test box

• Installation and warranty information

SB-7 WLAN test box

WLAN test requires defined position for the device.
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SRT-6 Opening tool

SRT-6 is used to open phone covers.

Note: The SRT-6 is included in the Nokia Standard Toolkit.

SS-210 Camera removal tool

The camera removal tool SS-210 is used to remove/attach the camera
module from/to the socket.

SS-46 Interface adapter

SS-46 acts as an interface adapter between the flash adapter and
FPS-21.

SS-62 Generic flash adapter
base for BB5

• generic base for flash adapters and couplers

• SS-62 equipped with a clip interlock system

• provides standardised interface towards Control Unit

• provides RF connection using galvanic connector or coupler

• multiplexing between USB and FBUS media, controlled by VUSB

SS-93 Opening tool

SS-93 is used for opening JAE connectors.

Note: The SS-93 is included in Nokia Standard Toolkit.
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SX-4 Smart card

SX-4 is a BB5 security device used to protect critical features in tuning
and testing.

SX-4 is also needed together with FPS-21 when DCT-4 phones are
flashed.

Cables
The table below gives a short overview of service devices that can be used for testing, error analysis, and
repair of product RM-529; RM-530; RM-584. For the correct use of the service devices, and the best effort of
workbench setup, please refer to various concepts.

CA-101 Micro USB cable

The CA-101 is a USB-to-microUSB data cable that allows connections
between the PC and the phone.

CA-31D USB cable

The CA-31D USB cable is used to connect FPS-21 to a PC. It is included
in the FPS-21 sales package.
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CA-35S Power cable

CA-35S is a power cable for connecting, for example, the FPS-21 flash
prommer to the Point-Of-Sales (POS) flash adapter.

CA-58RS RF tuning cable

Product-specific adapter cable for RF tuning.

• Table 9 Attenuation values

Band Attenuation Rx/Tx

GSM850/900 0.2...0.3 dB

GSM1800/1900 0.3...0.4 dB

WCDMA900 0.2...0.3 dB

WCDMA2100 0.3...0.4 dB

CA-89DS Cable

Provides VBAT and Flashbus connections to mobile device
programming adapters.
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DAU-9S MBUS cable

The MBUS cable DAU-9S has a modular connector and is used, for
example, between the PC's serial port and module jigs, flash adapters
or docking station adapters.

Note: Docking station adapters valid for DCT4 products.

PCS-1 Power cable

The PCS-1 power cable (DC) is used with a docking station, a module
jig or a control unit to supply a controlled voltage.

XRS-6 RF cable

The RF cable is used to connect, for example, a module repair jig to
the RF measurement equipment.

SMA to N-Connector approximately 610 mm.

Attenuation for:

• GSM850/900: 0.3+-0.1 dB

• GSM1800/1900: 0.5+-0.1 dB

• WCDMA/WLAN: 0.6+-0.1dB
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 Service concepts

POS (Point of Sale) flash concept

Figure 2 POS flash concept

Type Description

Product specific tools

BP-4L Battery

Other tools

FLS-5 POS flash dongle

PC with Phoenix service software

Cables

CA-101 Micro USB cable
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Flash concept with FPS-21

Figure 3 Basic flash concept with FPS-21

Type Description

Product specific devices

FS-114 Flash adapter

Other devices

FPS-21 Flash prommer box

AC-35 Power supply

PK-1 SW security device

SS-46 Interface adapter

PC with Phoenix service software

Cables

CA-89DS Service cable

USB cable
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CU-4 flash concept with FPS-21

Figure 4 CU-4 flash concept with FPS-21

Type Description

Product specific devices

FS-114 Flash adapter

Other devices

CU-4 Control unit

FPS-21 Flash prommer box

AC-35 Power supply

PK-1 SW security device

SS-62 Flash adapter base

SX-4 Smart card (for DCT-4 generation mobile device programming)

PC with Phoenix service software

Cables

PCS-1 Power cable

CA-89DS Service cable

Standard USB cable
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Type Description

USB cable

Module jig service concept

Figure 5 Module jig service concept

Type Description

Phone specific devices

MJ-222 Module jig

Other devices

CU-4 Control unit

FPS-21 Flash prommer box

PK-1 SW security device

SX-4 Smart card

PC with VPOS and Phoenix service software

Measurement equipment

Cables

CA-89DS Service cable

PCS-1 DC power cable

XRS-6 RF cable

USB cable
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Type Description

GPIB control cable

BB/RF tuning concept with module jig

Type Description

Product specific tools

MJ-222 Module jig

Other tools

CU-4 Control unit

PK-1 SW security device

SX-4 Smart card

PC with Phoenix service software

Smart card reader

Cables

DAU-9S MBUS cable

PCS-1 Power cable

XRS-6 RF cable

USB cable
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Bluetooth testing concept with SB-6

Figure 6 Service concept for RF testing and RF/BB tuning

Type Description

Product specific devices

FS-114 Flash adapter

Other devices

CU-4 Control unit

SS-62 Flash adapter base

PK-1 SW security device

SX-4 Smart card

SB-6 Bluetooth test and interface box

Smart card reader

PC with Phoenix service software

Cables

DAU-9S MBUS cable

PCS-1 DC power cable

USB cable
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WLAN functionality testing concept with SB-7

Figure 7 WLAN functionality testing concept with SB-7

Type Description

Product specific tools

FS-114 Flash adapter

Other tools

CU-4 Control unit

PCS-1 DC power cable

PK-1 SW Security device

SS-62 Generic base adapter

Cables

PCS-1 Power cable

DAU-9S Cable

Standard USB cable
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GPS testing concept with GPS RF coupler

Figure 8 RF testing concept with RF coupler

Type Description

Product specific devices

FS-114 Flash adapter

SA-131 GPS RF coupler

Other devices

CU-4 Control unit

SX-4 Smart card

JXS-1 RF shield box

PK-1 SW security device

SS-62 Flash adapter base

Smart card reader

Measurement equipment

PC with Phoenix service software

Cables

CA-58RS RF service cable (product-specific adapter cable)

PCS-1 Power cable

DAU-9S MBUS cable
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Type Description

XRS-6 RF cable

20dB attenuator

Interface cable

USB cable
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 Baseband self tests in Phoenix

Context
Always start the troubleshooting procedure by running the Phoenix self tests. If a test fails, please follow the
diagram below.

If the phone is dead and you cannot perform the self tests, go to Dead or jammed device troubleshooting
(page 3–7).
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Troubleshooting flow
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 Power and charging troubleshooting

Dead or jammed device troubleshooting

Troubleshooting flow
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Power key troubleshooting

Troubleshooting flow
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General voltage checking troubleshooting

Troubleshooting flow - Page 1 of 2
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Troubleshooting flow - Page 2 of 2
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General power checking
Check the following voltages:

Signal
Rename

Regulator Sleep Idle Nominal
voltage

Main user Notes

VIO Gazoo/Pearl ON ON 1.8 Memory, I/Os,
display, WLAN,
GPS

VBACK Gazoo/Pearl ON ON 2.5 Back-up
battery

VSIM1 Gazoo/Pearl ON ON 1.8/3.0 SIM card

VAUX1 Gazoo/Pearl ON ON 2.8 Display, 3D
magnetometer
, OFN

VAUX2 Gazoo/Pearl OFF OFF 2.5 ALS,
accelerometer

VANA Gazoo/Pearl ON ON 2.5 Not used

VR1 Gazoo/Pearl OFF ON 2.5 Crystal
oscillators

VRFC Gazoo/Pearl OFF ON 1.8 RAPU
converters

VRCP1 Gazoo/Pearl 4.75 To RF parts

VREF Gazoo/Pearl ON ON 1.25 RF reference

VCORE Gazoo/Pearl ON ON 1.2 RAPU digital Can change due
to RAPU version
& SW

VOUT Gazoo/Pearl OFF OFF 2.5 Not used

VCAM_2V8 N1401 OFF OFF 2.8 Camera Disabled in
sleep

VCAM_1V8 N1402 OFF OFF 1.800 Camera Disabled in
sleep

VMEM Gazoo/Pearl OFF OFF 2.9 microSD Disabled in
sleep
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Charging troubleshooting

Troubleshooting flow
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RTC troubleshooting

Troubleshooting flow
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 Interface troubleshooting

Flash programming fault troubleshooting

Troubleshooting flow - Page 1 of 2
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Troubleshooting flow - Page 2 of 2

Figure 9 Flashing pic 1. Take single trig measurement for the rise of the BSI signal
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Figure 10 Flashing pic 2. Take single trig measurement for the rise of the BSI signal
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SIM card troubleshooting

Troubleshooting flow
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MicroSD card troubleshooting

Troubleshooting flow
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USB interface troubleshooting

Troubleshooting flow
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 User interface troubleshooting

Keyboard troubleshooting

Context
There are two possible failure modes in the keyboard:

• One or more keys are stuck, so that the key does not react when a keydome or a side key is pressed. This
kind of failure is caused by mechanical reasons (dirt, rust, mechanical damage, etc.).

• Malfunction of several keys at the same time. This happens when one or more rows or columns in the key
matrix are failing (shortcut or open connection).

If the failure mode is not clear, start with the Keyboard test in Phoenix.

In this phone the keyboard is connected to D2800 I/O pins.

There are no serviceable parts for the optical navi key. Scratches on the joystick cover decrease its
performance. Self test ST_JOYSTICK_IF_TEST checks interfaces to the system module. If the self test fails, check
connector X2401 and UI module connector X2521.
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Troubleshooting flow
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Display module troubleshooting

General instructions for display troubleshooting

Context
• The display is in a normal mode when the phone is in active use.

• The operating modes of the display can be controlled with the help of Phoenix.

Table 10 Display module troubleshooting cases

Display blank There is no image on the display. The display looks
the same when the phone is on as it does when the
phone is off. The backlight can be on in some cases.

Image on the display not correct Image on the display can be corrupted or a part of
the image can be missing.

• If a part of the image is missing, change the
display module.

• If the image is otherwise corrupted, follow the
display fault troubleshooting flowchart.

Backlight dim or not working at all Backlight LED components are inside the display
module. Backlight failure can also be in the
connector or in the backlight power source in the
main engine of the phone.

This means that in case the display is working
(image OK), the backlight is faulty.

Visual defects (pixel) Pixel defects can be checked by controlling the
display with Phoenix. Use both colours, black and
white, on a full screen.

The display may have some random pixel defects
that are acceptable for this type of display. The
criteria when pixel defects are regarded as a display
failure, resulting in a replacement of the display, are
presented the following table.

Table 11 Pixel defects

Item White dot defect Black dot
defect

Total

1 Defect counts R G B White Dot
Total

1 1

1 1 1 1

2 Combined
defect counts

Not allowed.

Two single dot defects that are within 5 mm of each other should be
interpreted as combined dot defect.
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Steps
1. Verify with a working display that the fault is not on the display module itself.

The display module cannot be repaired.

2. Check that the cellular engine is working normally.

i To check the functionality, connect the phone to a docking station.

ii StartPhoenix service software.

iii Read the phone information to check that also the application engine is functioning normally (you
should be able to read the APE ID).

3. Proceed to the display fault troubleshooting flowchart.

Use the Display Test tool in Phoenix to find the detailed fault mode.

RM-529; RM-530; RM-584
BB Troubleshooting and Manual Tuning Guide

Page 3 –24 COMPANY CONFIDENTIAL Issue 1
Copyright © 2009 Nokia. All rights reserved.



Display fault troubleshooting

Troubleshooting flow
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Display backlight troubleshooting

Troubleshooting flow
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Magnetometer troubleshooting

Troubleshooting flow
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Accelerometer troubleshooting

Troubleshooting flow
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Ambient Light Sensor troubleshooting and re-calibration

Introduction to ALS troubleshooting and re-calibration
The Ambient Light Sensor (ALS) consists of the following components:

• Ambient Light Sensor (N1100). ALS is a digital I2C interface component that has two channels with different
spectral sensitivities. When combined, the component responds to illuminance similar as human eye.

• Vdd filtering capacitor (C1100)

The ALS components are located at the top side of the main PWB.

ALS information is used to control the keypad and display brightness of the phone. The keyboard backlight
is turned OFF, when it is not needed. Display brightness is dimmed, when environment lighting is dark. ALS
is calibrated in production and can be re-tuned in service points though not recommended unless calibration
coefficient is lost for some reason.

Note: ALS calibration is also required for Light SWAP Engines, because ALS is not factory calibrated
for Light SWAP.

When executing the ALS calibration, a reference phone that includes calibrated ALS is required. The ALS re-
tuning instructions show why the reference phone is needed.

Note: Make sure that you have completed the display and keyboard backlights troubleshooting
before starting the ALS troubleshooting.

There is an Ambient Light Sensor window in the Phoenix Display Test tool, which shows the luminance value.
The correct luminance in darkness is <20 lx, and in an office environment 100-2000 lx.

Note: The luminance value depends heavily on the light source and the angle of the phone against
the light source, so the values above can only be used as a rough guideline. Phoenix has an ambient
light sensor calibration tool for changing the calibration values.

Functionality check

Steps
1. Connect the phone to Phoenix, start the Phoenix software, and set the phone (e.g. on the table) so that

the ambient light visible to ALS is stable. The light quide of the ALS is located on the upper part of the
phone’s front cover, right next to the secondary camera.

2. Scan product on Phoenix (CTRL+R)
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3. Choose Testing→Display test.

4. Open the Lights tab, and check the Ambient light sensor check box. Click the Read button in order to get
the reference ambient light value. Cover the sensor and click Read again. When covered, the luminance
reading should be less than after clicking Read without covering the sensor.

5. If the component does not give any reading or the reading does not change when sensor is/is not covered,
replace the part.

Note: The ALS calibration procedure requires a reference phone with a calibrated ALS.
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ALS troubleshooting

Troubleshooting flow
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Calibrating ALS

Steps
1. Connect the phone to Phoenix, start the Phoenix software, and set the phone (e.g. on the table) so that

the ambient light visible to ALS is stable. The light quide of the ALS is located on the upper part of the
phone’s front cover, right next to the secondary camera.

2. Scan product on Phoenix (CTRL+R)

3. Choose Testing→Ambient Light Sensor Calibration.

4. Uncheck the Use default values only check box, click the Read button to get the AD-Count values for
Channel 0 and Channel 1, and write them down.

Note: In the example graphic the reference phone values are: Channel 0=3001 and Channel 1=337

5. Repeat steps 1-4 for the phone to be calibrated.

Note: Make sure the phone to be calibrated is located in the same place as the reference phone was
when luminance reading was taken.

6. Calculate and write down co-efficient value by division:

7. To calibrate ALS, the value in the Reference Level textbox needs to be adjusted for both channels until
the Co-efficient calculated by Phoenix equals the values calculated in step 6. Click Calibrate after each
try (and uncheck the Use default values only check box).

8. Calibration is done when the Co-efficient is equal to the co-efficient value calculated in step 6.

Note: Decimal numbers should be used in the iteration to achieve adequate precision (e.g.
200.2455)
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9. Use Phoenix (Testing→Display test→Lights  tab) to verify the calibration by reading the luminance value
for both the reference phone and calibrated phone.

Note: Remember that the illuminance readings for the reference and calibrated phones must be
done in the same ambient light conditions. If the illuminance values differ more than +- 10%, repeat
the whole ALS calibration procedure.

10. To end the calibration, click Close.

 Audio troubleshooting

Audio troubleshooting test instructions
External earpiece, internal earpiece and internal handsfree outputs can be measured either with a single-
ended or a differential probe.

When measuring with a single-ended probe each output is measured against the ground.

The input signal for each loop test is single-ended.

Required equipment
The following equipment is needed for the tests:

• Oscilloscope

• Function generator (sine waveform)

• Phoenix service software

• Battery voltage 3.7V

Test procedure
Audio can be tested using the Phoenix audio routings option. Three different audio loop paths are used in
the tests:

• AV mic to AV ear

• AV mic to HP ear

• Ext microphone in Int handsfree out

Note: The internal uplink microphones can be tested using the Phoenix self test "ST-DIGIMIC-TEST".
If the test result is PASS, the uplink microphones are electrically OK. For more thorough testing, see
section Internal microphone troubleshooting (page 3–37).

Each audio loop sets routing from the specified input to the specified output enables a quick in-out test. Loop
path gains are fixed and they cannot be changed using Phoenix. Correct pins and signals for each test are
presented in a table in the following section.

Phoenix audio loop tests and test results
The results presented in this table apply when no accessory is connected and battery voltage is set to 3.7V.

Earpiece, internal microphone and speaker are in place during measurement. Applying a headset accessory
during measurement causes a significant drop in measured quantities.

The gain values presented in the table apply for a differential output vs. single-ended/differential input.
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Loop test Input
terminal

Output
terminal

Path gain
[dB] (fixed)

Input voltage,
1 kHz sine
[mVp-p]

Single-ended
output

voltage [mVp-
p]

Output
DC level

[V]

AV mic to AV ear HS_MIC
and GND

HS_EAR_R and
GND

+21.3 100 584 0

HS_EAR_L and
GND

AV mic to HP ear HS_MIC
and GND

B2101 pad1
and GND

+18.2 100 407 1.5

B2101 pad2
and GND

Ext microphone
in Int handsfree
out

HS_MIC
and GND

B2102 pad1
and GND

+3.6 with
lowpass
filter

1000 758 with
lowpass filter

See the
Measurement
data graphics
below

NA

B2102 pad2
and GND

Measurement data

Figure 11 AV mic to AV ear, single-ended loop measurement. 16 kHz lowpass filter is used to attenuate noise from the
signal. The filter is optional.
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Figure 12 AV mic to HP ear, single-ended loop measurement. 62.5 kHz lowpass filter is used to attenuate noise from the
signal. The filter is optional.

Figure 13 Ext microphone in Int handsfree out, single-ended loop measurement without filter.
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Figure 14 Ext microphone in Int handsfree out, differential loop measurement with 8 kHz lowpass filter. The signal is
measured differentially between the pads of B2102.
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Internal earpiece troubleshooting

Troubleshooting flow
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Internal microphone troubleshooting

Troubleshooting flow
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EANC microphone testing

Context
For this test, Phoenix 2009.07.002.37336 or newer is needed.

Steps
1. Put the phone on the jig on a table.

The area around the phone should be free from objects. Ambient noise should be low so it does not disturb
the test.

2. Start Phoenix service software.

3. From the File menu, select Scan Product  and check that the correct product version is displayed.

4. Set the phone in test mode.

5. From the Testing menu, select Audio Control.

The Audio Control dialogue box is displayed.

6. Audio routing must be turned off before this test. In the Audio Control  window, select None and click
Activate.

Failing this, several dB of measurement error is created. Check this especially after uplink microphone
tests.

7. In the Audio Control  window, activate E-ANC Microphone Test.

The IHF speakers emit a 1 kHz tone and the EANC microphones measure the sound level.
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8. Close the error pop-up window, if it appears.

9. The test returns dB values for reference mic (the backside mic) and the error mic (the earpice mic).

Acceptable dB values are:

• Reference mic: -21 dB … -41 dB

• Error mic: -28 dB … -48 dB

A much lower value may indicate a fault in the microphone or a block in the sound inlet.

It is recommended to run this test more than once and observe the results. There may be an electrical
fault if a microphone gives exactly the same result each time.

The test returns also PASS/FAIL information for both microphones.
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Internal handsfree (IHF) troubleshooting

Troubleshooting flow
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External earpiece troubleshooting

Troubleshooting flow
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External microphone troubleshooting

Troubleshooting flow
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Acoustics troubleshooting

Introduction to acoustics troubleshooting
Acoustics design ensures that the sound is detected correctly with a microphone and properly radiated to
the outside of the device by the speaker. The acoustics of the phone include these basic systems: earpiece,
integrated handsfree (IHF), EANC error microphone, EANC reference microphone and two digital uplink
microphones.

The sound reproduced from the earpiece readiates through a single hole on the front cover (A-cover). The
sound reproduced from the IHF speaker radiates from the sound holes located on the bottom part of the
back cover. The EANC error microphone is located in the opening in the front of the earpiece. The reference
microphone is located at the bottom side and its sound hole is near the camera. The uplink microphones are
located on the top side of the PWB. The sound hole of the primary microphone is in the bottom, left corner.
The sound hole of the secondary microphone is in the keyboard near the Q-key.

For a correct functionality of the phone, all sound holes must be always open. When the phone is used, care
must be taken not to close any of those holes with a hand or fingers. The phone should be dry and clean,
and no objects must be located in such a way that they close any of the holes.
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Earpiece troubleshooting

Troubleshooting flow
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IHF troubleshooting

Troubleshooting flow
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EANC error microphone troubleshooting

Troubleshooting flow
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EANC reference microphone troubleshooting

Troubleshooting flow
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Microphone troubleshooting

Troubleshooting flow
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Vibra troubleshooting

Troubleshooting flow
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 Bluetooth and FM radio troubleshooting

Bluetooth troubleshooting

Troubleshooting flow
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FM radio troubleshooting

Troubleshooting flow
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 GPS troubleshooting

GPS failure troubleshooting

Context
GPS troubleshooting is broken down into two parts: general GPS failure troubleshooting and GPS basic checks
troubleshooting. The GPS failure troubleshooting flow can be followed and, where applicable, will feed into
the GPS basic checks troubleshooting flow.

Troubleshooting flow
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GPS basic checks troubleshooting

Troubleshooting flow
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 WLAN troubleshooting

WLAN functionality test using SB-7 and Phoenix

Steps
1. Place the phone on the SB-7 WLAN test box (see figure below). The co-ordinates are J4 (for the lower

left foot).

2. Start the phone to normal or offline (RF inactive) mode.

3. Search for SB-7 WLAN test box via the phone’s WLAN menu. Go to Menu→Ctrl.panel →Connectivity
→WLAN wiz., and the Searching for WLAN network pop-up window appears.

4. The SB-7 access point is named default. Connect to the SB-7 access point by selecting the WLAN network
named default, and then go to Options→Start web browsing. After this, go to
Options→Go to New web page. Select Go to without even typing any real web address. If the phone is
in offline mode, select Yes when the question Create WLAN connection in offline mode? pops up. The
device cannot connect to the internet through SB-7, but connection to access point default is now
established.

5. Check the signal level from the Connection Manager menu. Go to
Menu→Ctrl.panel→Connectivity→Conn. Mgr. →Active data connections. You should see the default
connection in the connection list with the connection time running. Go to Options→Details. Observe the
signal strength. Signal should show a signal strength Medium (35%) or higher.

Note: The local WLAN environment may affect test results, especially if there are many WLAN access
points nearby and any of them is using the same WLAN channel as SB-7. If you have problems
performing the test, consider repeating the test in a place where local networks do not interfere
with the lower strength signal of the SB-7 box.
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If you still cannot find the WLAN test box named default after scanning the networks, or if you have
connected to the test box but signal strength is lower that 235%, the WLAN functionality is not
working properly. In that case, proceed to WLAN failure troubleshooting.

WLAN layout and test points
The WLAN module has been optimised to achieve the smallest possible PWB area and adding test points will
compromise this layout efficiency. There is also an added risk that test point will compromise the WLAN
performance. Therefore there are no test points in the WLAN layout. Software tests will be used instead to
verify the operation of the WLAN module. The WLAN schematic is provided below.

WLAN settings for Phoenix
Use the following to test WLAN using Phoenix:

1 Set phone into Local Mode .

2 From the File menu, select Scan Product and check that the correct product version is displayed

3 From the Testing menu, select Self Test. This opens up a Self Test dialogue box, as shown below.
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Select the ST_WLAN_TEST check box as shown and then select Start button. The test turns on the WLAN, sets
up the SPI interface and then downloads the WLAN firmware into the WLAN module. During the download
the WLAN acknowledges the data blocks and so the self test is a good way to confirm that the WLAN module
is communicating with the Host. The result column will change to Passed after a few seconds if operating
properly.

In addition, a test of the WLAN to BT interface can be done by selecting the
ST_BT_WLAN_COEXISTENCE_TEST check box and selecting Start button.

This test verifies that the WLAN to BT co-existence interface signals are properly connected and there are no
open circuit or shorts on the four interface signals.

The co-existence interface comprises BT Txconfig, BT RF Active, BT Priority, and BT Frequency.
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In summary these two Self tests provide a simple means of ensuring the Host engine is able to communicate
with the WLAN module and check the interface to BT. More detailed WLAN performance test is covered in
WLAN functional test section.

WLAN functional tests

On/Off test
From the testing toolbar select WLAN Configuration option. This opens the WLAN configuration dialogue
box below. Selecting the Power state option button (as indicated), the WLAN can be turned ON and OFF:

1 With Power State set to OFF, measure the dc power supply current consumption of the flash adaptor.

2 Next return the Power state to ON and re-measure the dc power supply current of the flash adaptor.

The difference between the currents in (1) and (2) should be between 170 and 220 mA When WLAN is ON,
the firmware has been downloaded and the WLAN module is in the receive state. When OFF WLAN is powered
down.
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TX tests
From the testing toolbar select WLAN Tx Test option shown below. This test can be used to verify TX
configuration and functionality. The default settings are sufficient for testing the TX operation, although
other channels and data rates are equally suitable. To start the test, select the Start option button:

1 Measure and record the TX ON current consumption of the Phone/ flash adaptor.

2 Monitor the WLAN TX spectrum on a Spectrum analyser either using a co-ax cable connected to the WLAN
TX antenna port or by making a radiated test with a suitable WLAN antenna connected to the spectrum
analyser input. (When making a radiated test ensure that other WLAN devices are not transmitting as
these may be detected as well, confusing the result).

3 To finish the test select the Finish option button

4 Measure the TX OFF current consumption of the phone/flash adaptor.

The difference between the two readings should be 110 - 180 mA and measures the transmit current in
11MBPS, 802.11b mode of operation.
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RX Tests
There are different options available for testing the Rx path. The simplest is to use the WLAN to report Rx
packets when operating in an area where there is an active WLAN network. Simply starting an Rx test will
show the number of packets detected by the WLAN module as it monitors the network. However, it does
require a properly configured WLAN network. The alternative approach is to make a conducted test using a
signal generator connected to the WLAN antenna port. The drawback in this approach is that the WLAN
antenna connection in the phone is not actually tested.

From the testing toolbar select WLAN Rx Test option shown below. This test can be used to verify Rx
configuration and functionality.

To start the test, select the Start option button.

As the WLAN monitors an active WLAN network, the Rx test results window will update and show the number
of Frames received, as well as the Packer error rate. If there is no data reported in the "Rx test results" screen,
please change the "test channel" number.

Monitoring the detected frames is a simple method to verify the WLAN antenna and receiver path is working
properly. The current consumption of the phone/flash adaptor before and during the Rx test should be the
same (10 mA max difference).
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WLAN auto tuning
In case of WLAN ASIC change, RF power auto tuning is needed. Connect WLAN RF test connector to CMU200
input using proper RF cable. Start Phoenix WLAN autotune window. Check the settings and verify your PC
communicates with CMU200 via GPIB.

Auto tuning procedure
1 Start tuning by pressing Tune.
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Figure 15 WLAN auto tune settings
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Figure 16 WLAN auto tune results

RM-530 WLAN tuning target is 11 dBm. Use RM-530_wlan_size4.xml file in Program files/Nokia/Phoenix/
products/RM-529 and RM-530 directories.
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WLAN failure troubleshooting

Troubleshooting flow
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WLAN basic checks troubleshooting

Troubleshooting flow
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 Baseband manual tuning guide

Certificate restoring for BB5 products

Context
This procedure is performed when the device certificate is corrupted for some reason.

The procedure for certificate restoring is the following:

• Flash the phone with the latest available software using FPS-20 or FPS-21.

Note: USB flashing does not work for a dead BB5 phone.

• Create a request file.

• Send the file to Nokia by e-mail. Use the following addresses depending on your location:

• APAC: sydney.service@nokia.com

• CHINA: repair.ams@nokia.com

• E&A: salo.repair@nokia.com

• AMERICAS: fls1.usa@nokia.com

• When you receive a reply from Nokia, carry out certificate restoring.

• Tune the phone completely.

Note: SX-4 smart card is needed.

• If the phone resets after certificate restoring, reflash the phone again.

Required equipment and setup:

• Phoenix service software v 2008.34/38 or newer.

• The latest phone model specific Phoenix data package.

• PKD-1 dongle

• SX-4 smart card (Enables BB5 testing and tuning features)

• Activated FPS-20 flash prommer OR FPS-21 flash prommer

• Flash update package 08.30.012 or newer for FPS-20 or FPS-21 flash prommers

• CU-4 control unit

• USB cable from PC USB Port to CU-4 control unit

• Phone model specific adapter for CU-4 control unit

• PCS-1 cable to power CU-4 from external power supply

• XCS-4 modular cable between flash prommer and CU-4

Note: CU-4 must be supplied with +12 V from an external power supply in all steps of certificate
restoring.

Steps
1. Program the phone software.

i Start Phoenix and login. Make sure the connection has been managed correctly for FPS-20 or FPS-21.

ii Update the phone MCU software to the latest available version.

If the new flash is empty and the phone cannot communicate with Phoenix, reflash the phone.

iii Choose the product manually from File→Open Product , and click OK.

Wait for the phone type designator (e.g. “RM-1” ) to be displayed in the status bar.
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iv Go to Flashing→SW Update  and wait until Phoenix reads the product data as shown in the following
picture.

Product is automatically set according to the phone support module which was opened manually,
but the flash files cannot be found because the correct data cannot be read from the phone
automatically.

Code must be chosen manually, it determines the correct flash files to be used. Please choose the
correct product code (can be seen in the phone type label) from the dropdown list.

Flash Type must be set to Phone as Manufactured.

v To continue, click Start.

Progress bars and messages on the screen show actions during phone programming, please wait.
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Programming is completed when Flashing Completed message is displayed.

The product type designator and MCU SW version are displayed in the status bar.

vi Close the SW Update window and then choose File→Close Product .

2. Create a Request file.

For this procedure, you must supply +12 V to CU-4 from an external power supply.

i To connect the phone with Phoenix, choose File→Scan Product .

ii Choose Tools→Certificate Restore .

iii To choose a location for the request file, click Browse.
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iv Name the file so that you can easily identify it, and click Open.

The name of the file and its location are shown.

v To create the Request file, click Start.

vi When the file for certificate restore has been created, send it to Nokia as an e-mail attachment.

3. Restore certificate.

For this procedure, you must supply +12 V to CU-4 from an external power supply.

i Save the reply file sent by Nokia to your computer.

ii Start Phoenix service software.

iii Choose File→Scan Product .
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iv From the Tools menu, choose Certificate Restore and select Process a response file in the Action
pane.

v To choose the location where response file is saved, click Browse.

vi Click Open.

The name of the file and the path where it is located are shown.

vii To write the file to phone, click Start.
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4  — RF Troubleshooting
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 General RF troubleshooting

Introduction to RF troubleshooting

Most RF semiconductors are static discharge sensitive
ESD protection must be applied during repair (ground straps and ESD soldering irons).

Measuring equipment
All measurements should be done using:

• An oscilloscope for low frequency and DC measurements. Recommended probe: 10:1, 10Mohm//8pF.

• A radio communication tester including RF generator and spectrum analyser, for example Rohde & Schwarz
CMU200. (Alternatively a spectrum analyser and an RF generator can be used. Some tests in this guide are
not possible to perform if this solution is chosen).

Note: A mobile phone WCDMA transmitter should never be tested with full TX power (it is only
possible to perform the measurements in a good RF-shielded room). Even low power WCDMA
transmitters may disturb nearby WCDMA networks and cause problems to 3G cellular phone
communication in a wide area.

Note: All communication Test Set Screen dumps are from CMU200. Other testers are different.

Note: All measurements with an RF coupler should be performed in an RF-shielded environment
because nearby base stations can disturb sensitive receiver measurements. If there is no possibility
to use RF shielded environment, testing at frequencies of nearby base stations should be avoided.

Level of repair
The scope of this guideline is to verify functionality of the cellular RF block without removing RF shield.
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RF connector and antenna contacts

Figure 17 RF connector and antenna contacts - bottom
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Figure 18 Antenna matching components - top

 Auto tuning

Introduction to RF tunings
RF tuning is always performed with the help of a product-specific module jig, never with an RF coupler. Using
an RF coupler in the tuning phase will cause a complete mistuning of the RF part.

Cable and adapter losses
RF cables and adapters have some losses. They have to be taken into account when the phone is tuned. As
all RF losses are frequency dependent, the user has to act very carefully and understand the measurement
setup. For RF attenuations of the module jig and RF cable, please refer to the Service Tools section.

Auto tuning
This phone can be tuned automatically.
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Auto tuning is designed to align the phone's RF part easier and faster. It performs calibrations, tunings and
measurements of RX and TX. The results are displayed and logged in a result file, if initiated.

Hardware set up
For hardware requirements for auto tuning, please refer to Service concept for BB/RF tuning with module
jig.

Phoenix preparations
Install the phone specific data package, for example Nokia_firmware_RM-530_EUROPE_10.014_v41.0.exe. This
defines phone specific settings.

Auto tuning procedure
1 Make sure the phone (in the jig) is connected to the equipment. Otherwise some menus will not be shown

in Phoenix.

2 To go to autotune, select Tuning (Alt-U)→Auto-Tune (Alt-A)  from the menu.

3 Start autotuning by clicking the Tune button.

 Self Test Troubleshooting

Self test troubleshooting

Troubleshooting flow
Note: Self tests are recommended to be made when phone is in jig and 50 Ohm load is connected
to RF connector. Otherwise power tests may fail depending on antenna load.
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 Receiver Troubleshooting

Introduction to receiver (RX) troubleshooting
RX can be tested by making a phone call or in local mode. For the local mode testing, use Phoenix service
software.

The main RX troubleshooting measurement is RSSI reading. This test measures the signal strength of the
received signal. For GSM RSSI measurements, see GSM RX chain activation for manual measurements/GSM
RSSI measurement (page 4–10). For a similar test in WCDMA mode, see WCDMA RSSI measurement
(page 4–12).
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GSM RX chain activation for manual measurements/GSM RSSI measurement

Prerequisites
Make the following settings in Phoenix service software:

Setting GSM850 GSM900 GSM1800 GSM1900

Phoenix Channel 190 37 700 661

Signal generator
to antenna
connector

881.66771MHz 942.46771MHz 1842.86771MHz 1960.06771MHz

(67.71kHz offset) (67.71kHz offset) (67.71kHz offset) (67.71kHz offset)

at -60dBm at -60dBm at -60dBm at -60dBm

Steps
1. Set the phone to local mode.

2. Activate RSSI reading in Phoenix (Testing→GSM→RSSI reading )

Figure 19 Phoenix GSM RSSI reading window

Results
The reading should reflect the level of the signal generator (-losses) +/- 5 dB.

When varying the level in the range -30 to -102 dBm the reading should then follow within +/-5 dB.
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GSM receiver troubleshooting flowchart

Troubleshooting flow
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WCDMA RX chain activation for manual measurement

Steps
1. Via Phoenix Testing menu, choose WCDMA/RX Control.

2. In the RX control window, make the following settings:

Figure 20 Phoenix WCDMA RX Control window

Note: Channel for band WCDMA II 9800, V 4408, VIII 3012

3. Click Start to activate the settings.

If the settings are changed later on (for example, change of channel) you have to click Stop and Start
again.

Note: Clicking Stop also disables TX control if it was active.

WCDMA RSSI measurement

Prerequisites
WCDMA RX must be activated before RSSI can be measured. For instructions, please refer to WCDMA RX chain
activation. Connect signal generator to RF connector and use appropriate frequency for each channel (2141
MHz for channel 10700 WCDMA band I, WCDMA modulation).

Steps
1. Set the following RF generator settings:
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Figure 21 WCDMA RX generator settings

Note: Frequency for band WCDMA II 1961.0 MHz, V 882.6 MHz, VIII 943.4 MHz

2. From the Phoenix testing menu, select WCDMA→RX Power measurement

3. In the RX power measurement window, make the following settings:

Figure 22 Phoenix WCDMA RX power measurement window

4. Click Start to perform the measurement.

Note: WCDMA RSSI measurement is accurate only with WCDMA modulated signal.
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WCDMA receiver troubleshooting flowchart

Troubleshooting flow

 Transmitter Troubleshooting

General instructions for transmitter (TX) troubleshooting
Please note the following before performing transmitter tests:

• TX troubleshooting requires TX operation.

• Do not transmit on frequencies that are in use.

• The transmitter can be controlled in local mode for diagnostic purposes.

• The most useful Phoenix tool for GSM transmitter testing is “RF Controls”, in WCDMA transmitter testing
the best tool is “TX Control”.

• Remember that re-tuning is not a fix! Phones are tuned correctly in production.
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Note: Never activate the GSM or WCDMA transmitter without a proper antenna load. Always connect
a 50 Ω load to the RF connector (antenna, RF-measurement equipment or at least a 2 W dummy
load); otherwise the GSM or WCDMA Power amplifier (PA) may be damaged.

GSM transmitter troubleshooting

Steps
1. Set the phone to local mode.

2. Activate RF controls in Phoenix (Testing→GSM→Rf Controls ).

Make settings as shown in the figure:

Figure 23 Phoenix GSM RF controls window

3. Check the basic TX parameters (i.e. power, phase error, modulation and switching spectrum), using a
communication analyser (for example CMU200).
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4. Change power level (RF controls) and make sure the power reading follows accordingly.
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Next actions
If you want to troubleshoot the other bands, change band with RF controls and set the communication
analyser accordingly.

WCDMA transmitter troubleshooting

Steps
1. Set the phone to local mode.

2. In Phoenix, select Testing→WCDMA→TX control .

3. In the TX control window, make settings as in the picture:

Note: For WCDMA TX channels: band II 9400, V 4183, VIII 2787

4. Click Send to enable the settings and activate TX.

If settings are changed (eg. new channel), you have to click RF Stop and Send again.

5. Check the basic TX parameters using a communication analyzer (for example CMU200).
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Next actions
If you want to troubleshoot the other bands, change band with RF controls and set the communication
analyser accordingly.

 Antenna troubleshooting

Visual check for antenna contacts
There are two antenna contact springs (X7550 and X7551) for the cellular antenna. Check the shape of the
springs and replace if damaged.
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 Main (back) camera troubleshooting

Taking and evaluating test pictures with main camera
When taking a test picture, remember the following:

• Avoid bright fluorescent light, 50/60Hz electrical network or high artificial illumination levels

• If the phone is hot, let it rest for a while before taking the picture

• Make sure the optical system is clean

• Use highest possible resolution

• Make sure the light is sufficient (bright office lightning)

• Do not take the picture towards a light source

• Hold the phone as still as possible when taking the picture

• If camera has auto focus: Pictures should be taken both at infinity ~>2m and at macro distance ~10-15 cm
in order to verify auto focus functionality

When evaluating a test picture, remember the following:

• The center of the picture is sharper than the edges

• The image may be blurred, though it does not show in the viewfinder

• Analyse the picture from your PC monitor, full colour setting is recommended

• If possible, compare with a picture of the same motive taken with a similar Nokia device

• If camera has auto focus: Remember that the white focussing frame which appears when the camera
button is pressed halfway down, must turn green for auto focus lock. If the frame turns red, the camera
is not focussed!

Camera troubleshooting with Phoenix

Context
• Connect the phone to the flash jig.

• In test or local mode run the following self tests:
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Figure 24 Camera troubleshooting with Phoenix

Figure 25 Camera troubleshooting Phoenix self tests

Camera troubleshooting with self tests

Context
1 ST_CAMERA_IF_TEST

• Electrical interface problem. Camera connection or camera module is broken. Check the camera
assembly to the socket. Change the camera module if needed.

2 ST_SEC_CAMERA_IF_TEST
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• Electrical interface problem. Secondary camera connection or camera module is broken. Check the
components around the secondary camera.

3 ST_LED_FLASH_IF_TEST

• This tests the interface to the flash driver without the need of flash LED. If the test fails, check the driver
and components around it.

4 ST_LED_FLASH_TEST

• Note that when using camera application dim red flash is seen during still imaging even when the flash
is manually turned off. This is called an indicator and its normal behavior – do not change the
components.

• This test flashes both red indicator and white flash LED. If the flash is not visible, check the flash PWB
connection. Change the flash PWB if needed.

Autofocus (AF) failure

Steps
1. Use the camera application and focus the viewfinder image to a close distance by putting your finger on

top of the optical joystick. Another way to do the focusing, depending on the SW settings, is to press the
joystick button and hold it down until the focus is done.

• Focus is done when the green or red color is shown. Usually auto mode does not get green result when
the target is closer than 30-50 cm. To be able to focus to targets as close as 10 cm, please select close-
up mode from the side menu.

• Lens movement should be seen from the viewfinder when the camera is doing AF. If it is seen, the
camera is ok.

2. If the lens is not moving check fuse F1400 by measuring its resistance. The resistance should be close to
zero. Voltage measurement is not reliable since a broken fuse is not always totally open loop, but there
might be resistance of few kilo ohms.

3. If the fuse is broken, change the camera module and the fuse.
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Main camera bad image quality troubleshooting

Troubleshooting flow
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Camera flash troubleshooting

Context
Flash tests are described in Camera troubleshooting with self tests (page 5–6). Before checking flash
functionality, make sure that the main camera is working ok.

 Secondary (front) camera troubleshooting

Evaluating videocall picture quality from secondary camera
When testing the picture quality of a videocall, remember the following:

• Avoid bright fluorescent light, 50/60Hz electrical network or high artificial illumination levels

• Make sure the optical system is clean

• Make sure the light is suffiecient (bright office lightning)

• Do not take the picture towards light source

• Hold the phone as still as possible when evaluating the video call image quality.

• Distance should be approximately 40 cm

When evaluating the picture quality of a video call, remember the following:

Note: Always use the "troubled" phone when evaluating a picture in a video call. Do not evaluate
the picture on the receiving phone.

• The center of the picture is sharper than the edges

• If possible, compare with the picture on another Nokia device in a videocall, and of the same motive.

Secondary camera hardware troubleshooting

Context
The secondary camera can be tested with the camera application by selecting it from the Options menu.
Another option is to use a video call. For secondary camera hardware troubleshooting, see Camera
troubleshooting with Phoenix (page 5–5) and Camera troubleshooting with self tests (page 5–6).

Note: If a video call is used, always use the "troubled" phone when evaluating a picture in a video
call. Do not evaluate the picture on the receiving phone.

Secondary camera bad image quality troubleshooting

Context
Note: If a video call is used, always use the "troubled" phone when evaluating a picture in a video
call. Do not evaluate the picture on the receiving phone.
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Troubleshooting flow

RM-529; RM-530; RM-584
Camera Module Troubleshooting

Page 5 –10 COMPANY CONFIDENTIAL Issue 1
Copyright © 2009 Nokia. All rights reserved.



6  — System Module

Nokia Customer Care

Issue 1 COMPANY CONFIDENTIAL Page 6 –1
Copyright © 2009 Nokia. All rights reserved.



RM-529; RM-530; RM-584
System Module

(This page left intentionally blank.)

Page 6 –2 COMPANY CONFIDENTIAL Issue 1
Copyright © 2009 Nokia. All rights reserved.



Table of Contents
Introduction............................................................................................................................................................6–5

Phone description .............................................................................................................................................6–5
Energy management..............................................................................................................................................6–9

Battery and charging ........................................................................................................................................6–9
Normal and extreme voltages .........................................................................................................................6–9
Power key and system power-up ................................................................................................................. 6–10
Modes of operation ........................................................................................................................................ 6–10
Clocking scheme ............................................................................................................................................. 6–10
Power distibution .......................................................................................................................................... 6–11

SIM interface ........................................................................................................................................................ 6–12
MicroSD card interface ........................................................................................................................................ 6–12
USB ........................................................................................................................................................................ 6–12

USB interface................................................................................................................................................... 6–12
MicroUSB connector ....................................................................................................................................... 6–12

User interface....................................................................................................................................................... 6–12
Display interface............................................................................................................................................. 6–12
Keyboard interface......................................................................................................................................... 6–12
Ambient light sensor (ALS) interface............................................................................................................ 6–13
Accelerometer................................................................................................................................................. 6–13
Magnetometer ................................................................................................................................................ 6–13

GPS interface ........................................................................................................................................................ 6–14
WLAN interface .................................................................................................................................................... 6–14
Camera interface ................................................................................................................................................. 6–14
Audio interface .................................................................................................................................................... 6–14
Bluetooth interface ............................................................................................................................................. 6–14
FM radio interface................................................................................................................................................ 6–15
RF description ...................................................................................................................................................... 6–15

Receiver (RX) ................................................................................................................................................... 6–15
Transmitter (TX) ............................................................................................................................................. 6–15

List of Tables
Table 12 Nominal voltages....................................................................................................................................6–9

List of Figures
Figure 26 RM-529/RM-530 System module block diagram ................................................................................6–7
Figure 27 RM-584 System module block diagram ..............................................................................................6–8
Figure 28 Battery pin order ...................................................................................................................................6–9
Figure 29 Power distribution diagram ............................................................................................................. 6–11
Figure 30 MicroUSB connector ........................................................................................................................... 6–12

RM-529; RM-530; RM-584
System Module

Issue 1 COMPANY CONFIDENTIAL Page 6 –3
Copyright © 2009 Nokia. All rights reserved.



RM-529; RM-530; RM-584
System Module

(This page left intentionally blank.)

Page 6 –4 COMPANY CONFIDENTIAL Issue 1
Copyright © 2009 Nokia. All rights reserved.



 Introduction

Phone description
RAPUYAMA is the main digital baseband ASIC in the phone. It contains functionality for both WCDMA and GSM
EDGE.

GAZOO/PEARL (N2200) is the main audio and energy management controller for the phone.

Key components

Function Description Item ref

Main PWB 2WS

UI flex PWB 2WT

Flash light PWB 2YD

AV flex PWB 2WU

Baseband ASIC EM ASIC GAZOO/PEARL N2200

RF ASIC VAPAUS N7500

Processor RAPUYAMA D2800

GSM PA Front end module (FEM), quad band N7520

WCDMA PA N7540

Oscillators VCTCXO

TCXO

G7500

G3390

Memory Combo 1G DDR + 4G M3 D3000

Back-up capacitor RTC back-up capacitor G2200

Bluetooth BTFMRDS2.2M module N6000

FM radio BTFMRDS2.2M module N6000

WLAN WLAN module N6300

GPS GPS module N6200

USB USB tranceiver D3300

Battery BP-4L

Battery connector Tabby blade interface X2070

UI flex connector Board-to board connector for UI flex module X2401

Flash light connector Spring connector for flash light module X1401

AV flex connector Spring connector for AV flex assembly X2002

Display connector Board-to-board connector X2450

RF connectors X6400

X7505

USB connector X3300
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Key component placement
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System module block diagram

Figure 26 RM-529/RM-530 System module block diagram
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Figure 27 RM-584 System module block diagram
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 Energy management

Battery and charging

BP-4L battery
The phone is powered by a 3-pole BP-4L 1500 mAh battery. The three poles are named VBAT, BSI and GND
where the BSI line is used to recognize the battery capacity. This is done by means of an internal battery pull
down resistor.

Figure 28 Battery pin order

The battery temperature is estimated by measuring separate battery temperature NTC via the BTEMP line.
This is located on the main PWB, at the place where the phone temperature is closest to the battery
temperature.

Battery connector
The battery connector is a blade connector. It has three blades;

• BSI (Battery size indicator)

• GND (Ground)

• VBAT (Battery voltage)

The BSI line is used to recognize the battery capacity by a battery internal pull down resistor.

Charging
The phone is charged through the charging connector and micro USB interface.

Charging is controlled by energy management, and external components are needed to protect the baseband
module against EMC, reverse polarity and transient frequency deviation.

Charging a dead battery
Charging of a dead battery has to be carried out via an approved NOKIA charger. Charging of a dead battery
via a PC is not allowed since this procedure is not including a current regulator (the battery can be charged
with a too high current level).

Normal and extreme voltages
Energy management is mainly carried out in the EM ASIC (N2200). that contains a number of regulators. In
addition there are also some external regulators.

In the table below normal and extreme voltages are shown when a BP-4L battery is used.

Table 12 Nominal voltages

Voltage Voltage [V] Condition

General Conditions

Nominal voltage 3.700

Lower extreme voltage 3.5
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Voltage Voltage [V] Condition

Higher extreme voltage

4.1(fast charging)

HW Shutdown Voltages

Vmstr+ 2.1 ± 0.1 Off to on

Vmstr- 1.9 ± 0.1 On to off

SW Shutdown Voltages

Sw shutdown 3.1 In call

Sw shutdown 3.2 In idle

Min Operating Voltage

Vcoff+ 2.9 ± 0.1 Off to on

Vcoff- 2.7 ± 0.1 On to off

Power key and system power-up
When the battery is placed in the phone, the power key circuits are energized. When the power key is pressed,
the system boots up (if an adequate battery voltage is present).

Power down can be initiated by pressing the power key again and the system is powered down with the aid
of SW. The power key is connected to EM ASIC (N2200) via the PWRONX signal.

Modes of operation

Mode Description

NO_SUPPLY (Dead) mode means that the main battery is not present or its voltage is too low (below
EM ASIC master reset threshold) and that the back-up battery voltage is too low.

BACK_UP The main battery is not present or its voltage is too low but back-up battery voltage is
adequate and the 32 kHz oscillator is running (RTC is on).

PWR_OFF In this mode (warm), the main battery is present and its voltage is over EM ASIC master
reset threshold. All regulators are disabled, PurX is on low state, the RTC is on and the
oscillator is on. PWR_OFF (cold) mode is almost the same as PWR_OFF (warm), but the
RTC and the oscillator are off.

RESET RESET mode is a synonym for start-up sequence. RESET mode uses 32kHz clock to count
the REST mode delay (typically 16ms).

SLEEP SLEEP mode is entered only from PWR_ON mode with the aid of SW when the system’s
activity is low.

FLASHING FLASHING mode is for SW downloading.

Clocking scheme
In BB5.44, two main clocks are provided to the system: 38.4MHz RF clock produced by VCTCXO in the RF section
and 32.768kHz sleep clock produced by EM ASIC N2200 with an external crystal.

32 k Sleep Clock is always powered on after startup. Sleep clock is used by RAPU for low-power operation.

SMPS Clk is 2.4MHz clock line from RAPU to EM ASIC N2200. In deep sleep mode, when VCTCXO is off, this signal
is set to '0'-state.
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CLK600. The clock source is an internal RC oscillator in EM ASIC N2200 (during the power-up sequence) or
RAPU SMPS Clk.

Bluetooth and WLAN have a separate 38.4MHz TCXO clock oscillator.

Power distibution

Figure 29 Power distribution diagram
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 SIM interface
The phone has a SIM (Subscriber Identification Module) interface including a SIM connector. The connector
is only accessible when the battery is removed.

The SIM interface consists of an internal interface between RAPU and EM ASIC (N2200), and an external
interface between EM ASIC and SIM connector contacts.

The EM ASIC handles the detection of the SIM card. The detection method is based on the BSI line. Because of
the location of the SIM connector, removing the battery causes a quick power down of the SIM interface.

The SIM interface supports both 1.8V and 3.0V SIM cards. The SIM interface voltage is first 1.8 V when the SIM
card is inserted, and if the card does not response to the ATR (Answer to Request), a 3V interface voltage is
used.

For SIM interface, see the System module block diagram in Phone description (page 6–5).

 MicroSD card interface
The microSD card interface has one internal interface between RAPU and EM ASIC and one external interface
between EM ASIC and the microSD card.

The removal of a microSD card is detected by a push detect switch.

For MicroSD card interface, see the System module block diagram in Phone description (page 6–5).

 USB

USB interface
The phone has an interface for USB (Universal Serial Bus). USB is a differential serial bus that provides a wired
connectivity between a PC and peripheral devices, as in this case a mobile phone.

The phone supports USB 2.0 with High-Speed (480 Mbps).

Hot swap is supported, which means that USB devices may be plugged in and out at any time.

For USB interface, see the System module block diagram in Phone description (page 6–5).

MicroUSB connector
This phone is provided with a specific connector for microUSB.

Figure 30 MicroUSB connector

 User interface

Display interface
The System module block diagram illustrates the display interface, see Phone description (page 6–5).

Display backlight is provided directly by EM ASIC.

Keyboard interface
The System module block diagram shows the keyboard interface, see Phone description (page 6–5). The
keyboard interface is implemented with RAPU’s GENIOs. Keyboard GENIOs are protected from ESD with 10-
channel ASIPs Z2400 and Z2401.
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The keyboard illumination is handled by a separate LED driver. The driver is controlled by I2C bus.

Optical navi key interface
The optical finger navigation (OFN) sensor is connected to I2C bus. Two GENIOs are reserved for interrupts
and two others for reset and shutdown functions.

The OFN sensor captures the image of finger print and detects the direction of finger movement. This is done
by using IR LED whose light is reflected from the finger to the sensor through a lens.

Ambient light sensor (ALS) interface
Ambient light sensor information is used to control keyboard and display brightness.

• Keyboard backlight is turned OFF, when it is not needed.

• Display brightness is dimmed, when environment lighting is dark.

The ambient light sensor is calibrated in production and can be re-tuned in service points, though not
recommended unless calibration coefficient is lost for some reason.

For ALS interface, see the System module block diagram in Phone description (page 6–5).

Accelerometer
The accelerometer measures the static acceleration of gravity in tilt-sensing applications, as well as dynamic
acceleration resulting from motion or shock.

It has the following features:

• 2.16V to 3.6V supply voltage

• 1.8V compatible IOs

• Low power consumption

• ±2g/±8g dynamically selectable scale

• I2C/SPI digital output interface

• Embedded self test

• 10000g high shock survivability

• Pb free/RoHS compliancy

The accelerometer (N1102) is connected to I2C. One GENIO is reserved for interrupt.

For accelerometer interface, see the System module block diagram in Phone description (page 6–5).

Magnetometer
The device has an I2C controlled 3-axis magnetometer for compassing purpose.

The magnetometer has the following features:

• 3-axis magnetometer device suitable for compass application

• Built-in A to D converter for magnetometer data out

• Self test function

• I2C bus interface

• Power modes: OFF mode, stand-by mode and active mode

• DRDY function for measurement data ready

• INT function to inform exceeding magnetic field strength threshold.

The operating temperature is -20°C to +85°C.

The operating supply voltages are:
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• Analogue supply +2.4V to +3.6V

• Digital interface supply +1.70V to analogue supply voltage.

For magnetometer interface, see the System module block diagram in Phone description (page 6–5).

 GPS interface
The device includes an inbuilt GPS receiver and it works as a stand-alone positioning device.

The GPS system is connected to RAPU ASIC.

For GPS interface, see the System module block diagram in Phone description (page 6–5).

 WLAN interface
The phone contains a WLAN transceiver, that provides a fully integrated wireless radio solution. The WLAN
transceiver supports the IEEE 802.11 standards for low error rate data transfer between mobiles and WLAN
networks. Data rates up to 54Mbps are possible in 802.11g mode of operation.

WLAN shares the antenna with Bluetooth.

The WLAN software is downloaded from RAPU when WLAN is turned on, over the dedicated SPI interface.

For WLAN interface, see the System module block diagram in Phone description (page 6–5).

 Camera interface
The device has an autofocus (AF) type main camera.

In this device the main camera, the secondary camera and the camera flash driver are connected directly to
RAPU and controlled by the I2C bus, port 0. Both cameras are supplied by separate voltage regulators enabled
by the camera software (GENIOs).

Control signals to and from the camera flash driver are connected directly to RAPU (GENIOs).

For camera interface, see the System module block diagram in Phone description (page 6–5).

 Audio interface
The System module block diagram illustrates the audio interface of the phone, see Phone description
(page 6–5).

The digital uplink microphones are connected directly to RAPU. There are two uplink microphones, primary
and secondary, which are required for the uplink Two Microphone Noise Cancellation (2micNC) algorithm
and are located at the lower end of the phone.

Stereo output is provided by a separate stereo audio amplifier which is connected to EM ASIC. The output
from the stereo audio amplifier is fed to the AV connector.

The earpiece is driven by Tulppa chip which includes an amplifier and Earpiece Active Noise Control (EANC).
The EANC uses two digital microphones: the one next to the earpiece is called error microphone and the other
close to the main camera is called reference microphone.

The stereo IHF speaker is driven directly by a built-in stereo amplifier included in EM ASIC.

The vibra is driven directly by a built-in amplifier included in EM ASIC.

 Bluetooth interface
Bluetooth provides a fully digital link for communication between a master unit (the phone) and one or more
slave units (e.g. a wireless headset). Data and control interface for a low power RF module is provided by the
BTHFM module.

Bluetooth is physically integrated with FM radio in the BTHFM module ASIC, but from a functional point of
view they have nothing in common.
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The BTHFM module is powered by VBAT and the regulated voltage VIO. For audio applications the Bluetooth
has a PCM data bus. In addition an UART (universal asynchronous receiver/transmitter) is used for data
communication and controls.

Bluetooth shares the antenna with WLAN.

For Bluetooth interface, see the System module block diagram in Phone description (page 6–5).

 FM radio interface
The FM radio system is controlled by RAPU via the I2C bus. EM ASIC delivers the needed voltages and the clock
reference (32.768kHz SleepClk). EM ASIC also processes the analog audio.

The FM receiver fully supports reception over US/European (87.5MHz to 108MHz) FM band. The FM receiver
comprises an RF receiver with fully integrated VCO, a stereo FM demodulator and an RDS demodulator.

A headset accessory is used as an external antenna. The headset is connected to the AV connector.

The FM radio is physically integrated with Bluetooth in the BTHFM module ASIC, but from a functional point
of view the FM radio and Bluetooth have nothing in common.

For FM radio interface, see the System module block diagram in Phone description (page 6–5).

 RF description

Receiver (RX)
An analogue signal is received by the phone's antenna. The signal is converted to a digital signal and is then
transferred further to the baseband (e.g. to the earpiece).

The receiver functions are implemented in the RF ASIC.

Signals with different frequencies take different paths, therefore being handled by different components.
The principle of GSM and WCDMA is the same.

Transmitter (TX)
The digital baseband signal (e.g. from the microphone) is converted to an analogue signal, which is then
amplified and transmitted from the antenna. The frequency of this signal can be tuned to match the bandwith
of the system in use (e.g. GSM900).

The transmitter functions are implemented in the RF ASIC.

Even though the GSM and WCDMA signals are sent via different components, the principle of the transmission
is the same.

RM-529; RM-530; RM-584
System Module

Issue 1 COMPANY CONFIDENTIAL Page 6 –15
Copyright © 2009 Nokia. All rights reserved.



RM-529; RM-530; RM-584
System Module

(This page left intentionally blank.)

Page 6 –16 COMPANY CONFIDENTIAL Issue 1
Copyright © 2009 Nokia. All rights reserved.



Glossary

Nokia Customer Care

Issue 1 COMPANY CONFIDENTIAL Page Glossary–1
Copyright © 2009 Nokia. All rights reserved.



RM-529; RM-530; RM-584
Glossary

(This page left intentionally blank.)

Page Glossary–2 COMPANY CONFIDENTIAL Issue 1
Copyright © 2009 Nokia. All rights reserved.



A/D-converter Analogue-to-digital converter

ACI Accessory Control Interface

ADC Analogue-to-digital converter

ADSP Application DPS (expected to run high level tasks)

AGC Automatic gain control (maintains volume)

ALS Ambient light sensor

AMSL After Market Service Leader

ARM Advanced RISC Machines

ARPU Average revenue per user (per month or per year)

ASIC Application Specific Integrated Circuit

ASIP Application Specific Interface Protector

B2B Board to board, connector between PWB and UI board

BA Board Assembly

BB Baseband

BC02 Bluetooth module made by CSR

BIQUAD Bi-quadratic (type of filter function)

BSI Battery Size Indicator

BT Bluetooth

CBus MCU controlled serial bus connected to UPP_WD2, UEME and Zocus

CCP Compact Camera Port

CDMA Code division multiple access

CDSP Cellular DSP (expected to run at low levels)

CLDC Connected limited device configuration

CMOS Complimentary metal-oxide semiconductor circuit (low power consumption)

COF Chip on Foil

COG Chip on Glass

CPU Central Processing Unit

CSD Circuit-switched data

CSR Cambridge silicon radio

CSTN Colour Super Twisted Nematic

CTSI Clock Timing Sleep and interrupt block of Tiku

CW Continuous wave

D/A-converter Digital-to-analogue converter

DAC Digital-to-analogue converter

DBI Digital Battery Interface

DBus DSP controlled serial bus connected between UPP_WD2 and Helgo
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DCT-4 Digital Core Technology

DMA Direct memory access

DP Data Package

DPLL Digital Phase Locked Loop

DSP Digital Signal Processor

DTM Dual Transfer Mode

DtoS Differential to Single ended

EDGE Enhanced data rates for global/GSM evolution

EGSM Extended GSM

EM Energy management

EMC Electromagnetic compatibility

EMI Electromagnetic interference

ESD Electrostatic discharge

FCI Functional cover interface

FM Frequency Modulation

FPS Flash Programming Tool

FR Full rate

FSTN Film compensated super twisted nematic

GMSK Gaussian Minimum Shift Keying

GND Ground, conductive mass

GPIB General-purpose interface bus

GPRS General Packet Radio Service

GSM Group Special Mobile/Global System for Mobile communication

HSDPA High-speed downlink packet access

HF Hands free

HFCM Handsfree Common

HS Handset

HSCSD High speed circuit switched data (data transmission connection faster than GSM)

HW Hardware

I/O Input/Output

IBAT Battery current

IC Integrated circuit

ICHAR Charger current

IF Interface

IHF Integrated hands free

IMEI International Mobile Equipment Identity
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IR Infrared

IrDA Infrared Data Association

ISA Intelligent software architecture

JPEG/JPG Joint Photographic Experts Group

LCD Liquid Crystal Display

LDO Low Drop Out

LED Light-emitting diode

LPRF Low Power Radio Frequency

MCU Micro Controller Unit (microprocessor)

MCU Multiport control unit

MIC, mic Microphone

MIDP Mobile Information Device Profile

MIN Mobile identification number

MIPS Million instructions per second

MMC Multimedia card

MMS Multimedia messaging service

MP3 Compressed audio file format developed by Moving Picture Experts Group

MTP Multipoint-to-point connection

NFC Near field communication

NTC Negative temperature coefficient, temperature sensitive resistor used as a
temperature sensor

OMA Object management architecture

OMAP Operations, maintenance, and administration part

Opamp Operational Amplifier

PA Power amplifier

PCM Pulse Code Modulation

PDA Pocket Data Application

PDA Personal digital assistant

PDRAM Program/Data RAM (on chip in Tiku)

Phoenix Software tool of DCT4.x and BB5

PIM Personal Information Management

PLL Phase locked loop

PM (Phone) Permanent memory

PUP General Purpose IO (PIO), USARTS and Pulse Width Modulators

PURX Power-up reset

PWB Printed Wiring Board
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PWM Pulse width modulation

RC-filter Resistance-Capacitance filter

RDS Radio Data Service

RF Radio Frequency

RF PopPort™ Reduced function PopPort™ interface

RFBUS Serial control Bus For RF

RSK Right Soft Key

RS-MMC Reduced size Multimedia Card

RSS Web content Syndication Format

RSSI Receiving signal strength indicator

RST Reset Switch

RTC Real Time Clock (provides date and time)

RX Radio Receiver

SARAM Single Access RAM

SAW filter Surface Acoustic Wave filter

SDRAM Synchronous Dynamic Random Access Memory

SID Security ID

SIM Subscriber Identity Module

SMPS Switched Mode Power Supply

SNR Signal-to-noise ratio

SPR Standard Product requirements

SRAM Static random access memory

STI Serial Trace Interface

SW Software

SWIM Subscriber/Wallet Identification Module

TCP/IP Transmission control protocol/Internet protocol

TCXO Temperature controlled Oscillator

Tiku Finnish for Chip, Successor of the UPP

TX Radio Transmitter

UART Universal asynchronous receiver/transmitter

UEME Universal Energy Management chip (Enhanced version)

UEMEK See UEME

UI User Interface

UPnP Universal Plug and Play

UPP Universal Phone Processor

UPP_WD2 Communicator version of DCT4 system ASIC
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USB Universal Serial Bus

VBAT Battery voltage

VCHAR Charger voltage

VCO Voltage controlled oscillator

VCTCXO Voltage Controlled Temperature Compensated Crystal Oscillator

VCXO Voltage Controlled Crystal Oscillator

VF View Finder

Vp-p Peak-to-peak voltage

VSIM SIM voltage

WAP Wireless application protocol

WCDMA Wideband code division multiple access

WD Watchdog

WLAN Wireless local area network

XHTML Extensible hypertext markup language

Zocus Current sensor (used to monitor the current flow to and from the battery)
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